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Legal Notice

Geberit ProPlanner 2016

These instructions and the software described in it form part of the license agreement and may 
be used or copied only in accordance with the license terms. The content of these instructions is 
intended exclusively for information purposes, may be changed without notification and does not 
entail an obligation on the part of Geberit Verwaltungs AG. Geberit Verwaltungs AG provides no 
warranty nor guarantee with regard to the correctness and accuracy of the data in these 
instructions.

Any mention of company names in sample templates is exclusively for demonstration purposes 
and reference to any actual organisation is unintentional, with the exception of the following. The 
following companies and brands are mentioned in these instructions: 

• Geberit and the Geberit logo are trademarks of the Geberit Group in Switzerland and in other 
countries

• Microsoft, Windows 10, Windows 8.1, Windows 8 and Windows 7 are brands of the 
Microsoft Corporation in the USA and other countries

• Autodesk® RealDWG is a brand of Autodesk in the USA and other countries 
• YouTube
• Adobe Acrobat Reader

© Copyright 2016, Geberit Verwaltungs AG. All rights reserved.

Geberit Verwaltungs AG is legally represented by Roland Iff and Rudolf Eberhard.

Geberit Verwaltungs AG

Schachenstrasse 77

CH-8645 Jona, Switzerland

Phone number: +41 55 221 6111

Fax: +41 55 221 6242

E-mail: verwaltungs.ag.ch@geberit.com

Commercial register entry: Company registration number CH-320.3.010.425-2 (Company 
Register of the Canton of St. Gallen)

Value Added Tax no: CHE-116.306.913

Find the sales company in your country at www.geberit.com or via the Internet link on the 
software's start page.
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1 About this Document

Use this Training Manual during training but also to repeat what you have already learned.

You will learn how to work with Geberit ProPlanner with the aid of planning examples.

Characters and symbols

The following characters and symbols are used in this training manual:

Symbol Designation Meaning

Info Reference to further information on the subject under 
Help

Hint Hint for an easier or better method of operation 

Note Basic information on a specific procedure

Important note Information to be urgently noted. Failure to adhere to this 
can result in loss of data or extensive planning problems

Action Instruction for action consisting of only one step

1.
2.

Instruction for action consisting of several steps

Result Result of an action

Info

You can find additional information under Help, which you can call up using the Help menu or 
by pressing F1.
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User Interface

2 User Interface

After you have created a new project with the Detailed Planning 3D subproject, the following 
window appears:

(1) General toolbar (see page 6)
(2) Design area window
(3) Import installation walls window
(4) Favourites window
(5) Dimensions window
(6) Duct planning window
(7) Objects window
(8) Walls and installation walls window
(9) Detailed Planning 3D tool bar (see page 7)
(10) Message list
(11) Building window
(12) Wizards and settings window
(13) Front view window
(14) 3D view window
(15) Article information
(16) Project window

Design area window

Generate your plan for masonry and installation walls (Duofix, Geberit GIS) in the Design area 
window. The following commands are possible:

• Import figure or CAD plan (see page 62)
• Create rooms and walls (see page 35)
• Insert doors and windows (see page 35)
• Insert objects (see page 49)
• Edit rooms, walls and objects
• Import walls from installation systems
• Create walls with the Installation wall quick entry bar (see page 13)
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Import installation walls window

You can import and edit installation walls created with the Installation Systems module.

Favourites window

 The Favourites window contains all objects that have been saved as Favourites. 

Dimensions window

The plan can be measured in various styles.

Duct planning window

The Duct planning window includes elements for the planning of ducts for water supply 
connections, heating, ventilation and electrical installations.

Objects window

The Objects window contains sanitary objects, such  as bathtubs, washbasins and WCs, as well 
as additional objects with which piping systems can be planned. The objects are shown as 
standard with large symbols in the Objects window. You can change to the tree structure by 
right-clicking to open the pop-up menu.

Walls and installation walls window

The Masonry walls and installation walls window contains objects and functions for the 
planning of masonry, installation walls and ducts. Single dimensions and drawing modes can be 
defined for the objects.

Message list

Depending on the calculation, the Message list displays a report that contains the calculation 
errors, warning notes and information. Use the tabs to call up the messages for Detailed 
Planning 3D and filter them according to the Degree of severity using the right mouse key pop-
up menu. The messages are issued as standard as Information for the selected tab.

The following types are available in the pop-up menu:

Type Explanation

Error Only errors are displayed

Warning Errors and warnings are displayed

Information Errors, warnings and information are displayed (default setting)

Tip

• Double-clicking on the error message enlarges the error in the Design area window and 
highlights it in a colour according to the severity.

• Errors can be corrected in the message list using the Command column or the tool tip in 
the Design area window.
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Building window

The building in the Building window comprises floors, building stacks and installation units and 
can be extended as required. An installation unit is the smallest unit, in which it is possible to plan 
and for which a material list can be created. The installation unit can contain one or several 
rooms. The plan in the Design area window refers to the highlighted installation unit. You can also 
call up the Building and calculation settings window in the Building window and define settings 
for the following:

• Building
• Detailed Planning 3D
• GIS
• Duofix

Wizards and settings window

You can execute the following functions in the Wizards and settings window:

• Enter project data and subproject data
• Define building and calculation settings
• Show and hide layers
• Define module settings for Detailed Planning 3D

Front view and 3D view windows

Article information window

As soon as a subproject has been calculated, you can call up views, dimensional sketches and 
installation manuals for articles from the Geberit product range in the Article information 
window. If available, you can call up installation videos on YouTube via a link. You need to be 
connected to the internet for this.

You can obtain the following information:

• Photo and drawing of a selected article
• Dimensional sketches
• Link to the Geberit product catalogue
• Installation manual and installation notes in PDF format
• ZIP file with CAD drawing in DWG or DXF format
• Links to YouTube videos

Window Function

Front views
Shows the front view of the view selected. Gives an overview of the 
profiles and dimensions required.
• Zoom: Rotate the mouse wheel forwards or backwards or press W 

and S
• Move: Move mouse while holding down mouse wheel

3D view
Gives a spatial impression of the plan.
• Zoom: Rotate the mouse wheel forwards or backwards or press W 

and S
• Rotate: Move mouse while holding down the right mouse key
• Move: Move mouse while holding down mouse wheel
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Project window

The Project window displays the project currently open with its subprojects. 

You can execute the following functions in the Project window:

• Enter project data and subproject data
• Add, delete subprojects etc.
• Import subprojects from other projects

2.1 Toolbars and Menus

2.1.1 General Toolbar

All basic functions of Geberit ProPlanner can be called up via the General toolbar.

Info

You can access additional information under Help at Detailed Planning 3D >User interface.

Note

Disabled buttons appear light-grey.

Button Command

Create a new project

Open available project

Add subproject

Save project

Print / Export

Calculate subproject

Undo last command

Redo undone command

Cut object and copy to clipboard

Copy object to clipboard

Paste object from clipboard

Zoom into drawing frame
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Toolbars and Menus

2.1.2 Detailed Planning 3D Toolbar

The following functions are available with the Detailed Planning 3D module:

Extend drawing

Reduce drawing

Zoom in to all objects

Select zoom area with the mouse

Adapt drawing frame to drawing

Button Command

Move the drawing area

Add front view

Display front view arrows

Open layer

Select objects

Move objects

Move infotexts and dimensions

Automatically assigning reference points

Set reference point

Import figure or CAD plan
Image files can be imported

Insert text
You can set the font type, text colour etc. when designing

Insert line

Insert ellipse

Insert rectangle

Button Command
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3 Preparation

3.1 Creating a New Project

1. Start Geberit ProPlanner.
 The Geberit ProPlanner start page appears after a few seconds.

2. Make sure that Enter project data during creation and Enter building properties during 
creation are checked.

3. Create a new project by clicking on the button for Detailed Planning 3D.

 The New project window appears.

4. Enter the required information and confirm with Finish.
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Preparation

Creating a New Project

 The New project window is closed and the Building and calculation settings window 
appears.

5. Set the building size to the following values:
• Attic floors: 0
• Upper floors: 3
• Underground floors: 0
• Building stacks: 1

6. Confirm your entries with Apply.

7. Click on the lower installation unit and enter Small bathroom as the Designation.
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8. Click on the central installation unit and enter Large bathroom as the Designation.
9. Click on the upper installation unit and enter Guest WC as the Designation.
10. Select the GIS tab.

11. Make sure that Prefabricate is not checked.

12. Click on Close to apply the settings.
 The detailed planning view appears.
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Adapting the User Interface

3.2 Adapting the User Interface

The user interface can be adapted to meet your requirements. You can show and hide windows. 
This makes your planning clearer. 

Selecting default window layout

Geberit ProPlanner offers you the option of selecting one of two default layouts. A user-defined 
window layout can also be saved and restored if required.

 Click on Window layout in the View menu and select Default window layout 1.
 The user interface appears in the selected window layout.

Adapting the window layout

Rarely used windows can be hidden to extend the drawing area window.

 Click on  in the title bar of the Message list window.
 The window is hidden but remains visible at the bottom left corner as a tab.

Note

• Click on the respective tab if you wish to show the window temporarily.
• If you wish to show the window permanently, you can then click on  in the title bar of the 

window.
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Saving the window layout

You can save the preferred window layout and call it up again.

1. Click on Window layout in the View menu and select Save window layout.
 An information window appears.

2. Confirm the information window with OK.

3.3 Design Area Window

Create your plan in the floor plan in the design area window. At the moment only the drawing 
frame is available.

1. Turn the mouse wheel to extend or reduce the view.
2. Move the mouse, holding the mouse wheel down, to move the view.

3.4 Saving a Project

1. Click on Save in the toolbar to save the project.
 The Save project as window appears.

2. Select the required directory and save the file under the name Detailed planning 3D training 
example.gpp.

Note

You can call up your preferred window layout via the View > Window layout > User-defined 
window arrangement menu.

Important note

Save the project regularly.
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Detailed Planning 3D Planning Examples

Creating an Installation Wall with Quick Entry

4 Detailed Planning 3D Planning Examples

Use the Detailed Planning 3D module to plan Geberit installation walls with objects, such 
as washbasins, shower trays, WCs or bathtubs. You can also insert wall/floor openings, like 
windows and doors. You have the option of using a floor plan, front view or 3D view. You can 
draw Geberit Duofix and Geberit GIS installation walls and import image files as a template.

With the aid of two planning examples, you will learn in steps how to create installations using 
Detailed Planning 3D. The first example is a simple installation with an installation wall and 3 
objects. This installation is created using the Installation wall quick entry. Then you will learn how 
to dimension and print an installation.

The second planning example is a complete installation. The arrangement of the walls of the 
room are drawn and you will also learn how to insert doors and windows. Then you will design 
several partition walls and prewalls, both room-height and part-height, free-standing and 
incorporating corners. Finally you will place some objects, such  as a bathtub and a WC.

4.1 Creating an Installation Wall with Quick Entry

This chapter covers the following topics:

• Creating installation walls using the Installation wall quick entry
• Placing objects
• Adapting objects
• Dimensioning drawings
• Exporting graphics
• Printing the material list and installation instructions

A graphic visualisation of the planning example can be found at the end of the training manual 
(see page 72).

4.1.1 Using the Quick Entry

You can create an installation wall with the GIS and Duofix tools or with the Installation wall quick 
entry. Use the Installation wall quick entry to plan an installation wall including objects and then 
insert it into the drawing area. Use of the GIS and Duofix tools will be explained in the second 
planning example.

1. Select the Small bathroom installation unit in the Building window.
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2. Click on Installation wall quick entry in the Masonry and installation walls window.
 The Installation wall quick entry window appears.

The quick entry window includes different areas, such as Wall type and Wall coupling, 
which you can use to plan an installation wall in steps. The choice of a wall type affects the 
visualisation of the wall coupling and the input options for the dimensions. Therefore 
always adhere to the following principle when planning: from left to right and from top 
to bottom. This procedure will become clear in the following example.

Selecting the wall type

Specify the details of the installation wall in the Wall type area. Over and above the wall type, you 
can also select an installation system (GIS or Duofix) and the material of the base wall (solid wall 
or lightweight wall).

 Select the wall type Room-height/part-height combination.

Selecting the wall coupling

Select how the installation wall is to be fastened to the masonry in the Wall coupling area.

 Select the Fastened on both sides wall coupling.
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Entering the dimensions of the installation wall

In the Dimension area you can specify the height of a part-height wall and the width and depth 
of part-height and room-height installation walls. The overall height comes from the room height 
set in the Building properties. The field is highlighted in grey. 

With combined wall types, you also need to select the side of the room-height wall section.

1. Select the following dimensions for the installation wall in the Dimensions area:
• Height of the part wall: 120 cm
• Length of the total wall: 345 cm
• Length of the part wall: 255 cm
• Wall depth: 19 cm

2. Select Right as the side of the room-height wall section.

Selecting wall properties

Select the Panelling and Sound insulation of the installation wall in the Wall properties area.

 In the Panelling field, select GIS panel and in Sound insulation select Sound absorption 
inserts. 

Entering the object distance

In the Object distance area, you can enter the distance from the edge of the installation wall or 
from the object respectively. The distance between objects is determined using the central axes 
of the objects.

If the checkbox is selected, the objects are placed with the shortest possible distance defined in 
Geberit ProPlanner. In this case, the plan does not correspond to the circumstances on site but 
is exclusively used for material determination. 

You can specify in the Measured from field whether the distance of the object is to be measured 
from the left or right wall. If you click on an object placed in the installation wall, the distance will 
be measured from this object. You can freely select the distance providing the checkbox is 
deselected.

Note

You can call up the data sheets in a PDF format via the Info symbol . The data sheets 
contain information for dimensioning the selected installation wall, for example the minimum 
prewall and partition wall depths.

The information symbol  is market-dependent and is not available in all markets.

Tip

Using the  button between the Wall coupling and Object areas, you can 
show or hide the Wall type, Wall coupling and Dimension areas. The wall preview is extended 
when you hide the top part.
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1. Uncheck Insert in shortest possible distance.
2. In the Measured from: field, select Selected object.
3. Enter 100 cm as the Distance for the first object.

Inserting objects

Objects that you can place on the installation wall are selected in the Objects area. The various 
configurations of the objects appear in a tree structure. Use the  symbol to open and close the 
tree structure to select sanitary appliances with default configurations. You can then specify 
individual configurations using the properties of the objects. The default object in the first level is 
selected for the example.

1. Highlight the Washbasin.

2. Click on Insert object in installation wall.

3. Leave Selected object in the Measured from field to place the next object next to the blue 
highlighted object.

4. Enter 95 cm as the Distance.

Note

If no object has been entered, the distance is measured from the left wall.

Note

The default object in the first level is market-dependent. The figures shown here can therefore 
differ from your view in Geberit ProPlanner.
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Creating an Installation Wall with Quick Entry

5. Double-click on the WC to insert the WC into the installation wall.

6. Select Right wall side in the Measured from field.
7. Enter 45 cm as the Distance.
8. Double-click on the Shower to insert the shower into the installation wall.

Inserting installation walls

Once you have placed all the objects on the installation wall, the wall can be inserted into the 
drawing area.

1. In the Installation wall quick entry window, click on Insert.
 The wall is suspended from your cursor.

Info

Additional information can be found under Help at Detailed Planning 3D > Installation wall 
quick entry.
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2. Click on the desired position within the drawing area to place the wall.

4.1.2 Working with Your Planning Example

Once you have designed and inserted the installation wall using the Installation wall quick entry, 
you will then meet the different views in Detailed Planning 3D. Adjustments are made and at the 
end the planned installation unit is dimensioned.

4.1.2.1 Views in Detailed Planning 3D

A front view and a 3D view are available in addition to the plan view in the Design Area window. 
One wall side must be selected as the front view for the two views to be displayed.

Add front view

1. Click on Add front view in the toolbar.
2. Position the cursor on the wall.

3. Click in the drawing area to position the front view.

 The front view appears in the Front views window.
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Creating an Installation Wall with Quick Entry

You can move the drawing frame if the title block hides the drawing.

1. Highlight the drawing frame in the Front views window and click on Move objects in the 
toolbar.

2. Click on the moving point.

3. Use your mouse to move the drawing frame to the desired position.
4. Click on the drawing area.

Selecting the 3D view

1. Open the 3D view window.

Note

• If you are setting several front views, each front view is displayed on a separate tab
• Click on  in the tab to delete front views
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2. Navigate around the 3D view as follows:

4.1.2.2 Adapting the Shower

A shower with the dimensions 80x80 cm has been inserted in the Installation wall quick entry. In 
this step you will now adapt the size of the shower in line with the specifications of the planning 
example. The shower tap will also be moved.

Changing the size of the shower

1. Highlight the shower.
2. Right-click on the shower and select Properties in the pop-up menu.
 The Shower properties window appears.

3. Select the Ceramic appliance tab.

Movement Description

Zoom Rotate mouse wheel forward or backward

Move Move mouse while holding down mouse 
wheel

Turn Move mouse while holding down the right 
mouse key

Slide drawing to the front Press W

Slide drawing to the rear Press S

Slide drawing to the left Press A

Slide drawing to the right Press D

Tip

With the Layer  function, you can show and hide single parts (e. g. panelling) in the floor 
plan, front view and 3D view.
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4. Select a shower tray from the list with dimensions 90x90 cm.

5. Confirm with OK.
 The size of the shower has been adjusted.

Moving the shower tap

1. Show the Front views window.
2. Highlight the shower tap in the front view.

3. Right-click on the shower tap and select Positioning of tap in the pop-up menu.
 The Positioning of tap window appears.

4. Enter the following values to move the shower tap 10 cm to the left and to a height of 120 cm.

Note

Negative values move an object to the left and/or downwards, while positive values move an 
object to the right and/or upwards respectively.
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5. Confirm with OK.
 The shower tap has been moved.

4.1.2.3 Replacing the WC

In this section you will now learn how objects can be replaced. To do so, you will replace the 
default WC with another WC.

1. Highlight the WC.
2. Right-click on the WC and select Properties in the pop-up menu.
 The WC properties window appears.

3. Select a Geberit AquaClean Mera WC with a GIS installation element and a height of 112 or 
114 cm.

Note

The objects available are dependent on the market.
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4. Confirm with OK.
 The WC has been replaced.

4.1.2.4 Dimensions

The dimension lines can be placed manually or inserted automatically by Geberit ProPlanner. The 
construction dimensions are inserted in the Plan view. The construction dimensions are inserted 
automatically in this planning example. The dimension lines are then arranged sensible.

The fabrication dimensions are the basis for the installation and are only visible in the Front view 
and the 3D view.

Inserting dimensions

1. Click on Display front view arrows in the toolbar to hide the front view arrows.

2. Open the Dimensions window.

Note

Use the checkboxes in the Automatic dimensions area to define which dimensions are to 
be generated.
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3. Make sure that the Construction tab has been selected and click on Automatic 
dimensions.

 The construction dimensions have been inserted.

Moving dimension lines

1. Click on Move infotexts and dimensions in the toolbar.
2. Draw the dimension lines to the required position and click in the drawing area.

3. Press Esc to exit the function.

Note

You can highlight dimension lines, objects and walls that lie on top of each other using the 
Space bar. The area underneath the cursor is displayed in a selection menu as soon as you 
press the Space bar. You can select the required object using this selection menu. The 
object is then highlighted in blue.
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Dividing dimensional chains

Dimensional sections are always inserted into the drawing in a chain. You can divide these 
dimensional chains to edit single sections of dimensions.

1. Highlight the dimensional chain shown.

2. Right-click on the dimensional chain and select Divide dimensional chain in the pop-up 
menu.
 The dimensional chain is divided into single dimensional sections. You can now select 

them singly.

Deleting dimension lines

1. Highlight the left dimension line on the shower with the dimension 45.

2. Press DEL.
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Drawing dimension lines

1. Make sure that the Construction tab is selected in the Dimensions window.
2. Click on Insert horizontal dimensions.

3. Move the cursor to the right edge of the shower tap.
 The cursor appears as a cross-hair and capture mode is enabled.

4.  Click in the drawing area to set the starting point of the dimension line.
5. Move the cursor to the middle of the shower tap and click in the drawing.
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6. Move the cursor to the left edge of the shower and click.

7. Press Esc to finish drawing the dimension line.
 The dimension line is suspended from your cursor.

8. Move the dimension line to the required position and click in the drawing area.

Joining dimensional chains

You can join single dimensional sections to form a dimensional chain.

1. Highlight the dimensional sections shown.



28

Detailed Planning 3D Planning Examples

Creating an Installation Wall with Quick Entry

Detailed Planning 3D Training Manual
Geberit ProPlanner 2016

2. Right-click on the highlighted measurement sections and select Join dimensional chain.
 The single measurement sections are joined to form a dimensional chain.

Positioning dimension figures

You can position dimensional figures above or below the dimension line.

1. Highlight the dimensional chains shown.

2. Right-click on a highlighted dimensional chain and select Set dimensional figures on other 
side of the dimension line.

Info

Additional information can be found under Help at Detailed Planning 3D > Dimensions.
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4.1.3 Defining the Paper Format and Drawing Scale

Once you have completed the dimensions, adjust the paper format, alignment and the drawing 
scale. Select a paper format and alignment supported by your printer.

Defining the paper format

1. Double-click on the title block in the Design area window.
 The Paper format window appears.

2. Uncheck Apply the default settings.
3. For this example select Paper format A4 and Landscape as the Orientation.
4. Leave the drawing scale at 1:25.

5. Click on OK to apply the settings.
 The drawing frame was adapted.

There is still too much unused space around the drawing.
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Setting the drawing scale

Adapt the drawing frame to use the unused space within the drawing and visualise the drawing 
as large as possible within the drawing frame.

1. Click on Adapt drawing frame in the toolbar.
 The drawing frame is defined in such a way that your plan is visualised to fill the space. 

This is the smallest scale with which you can print your drawing on the selected paper 
format.

2. Double-click on the title block in the Design area window.
 The Paper format window appears.

The automatically calculated minimum scale of 1:18 or 1:19 appears automatically in the 
Scale field.

 

3. Increase the scale to the next standard ratio (i. e. 1:20).

4. Click on OK to apply the settings.
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4.1.4 Printing Graphics and Lists

Once you have completed the drawing, you can export the installation as a graphic and then 
create material lists, bills of materials and installation instructions.

Printing graphics

The following views can be printed as a graphic:

• Plan view
• Front views
• 3D view

1. Click on Print / Export in the toolbar.
 The Print / Export window appears.

2. Click on Graphics.

3. Select a printer in the Output area.
4. Select which views you wish to print in the Graphics area.
5. Click on Print.

Printing lists and graphics

There are different list types available when creating an offer, for example Material lists and 
Installation instructions. Use List settings to specify which materials are to be considered and 
which surcharges are to be used as the basis for the calculation. Enter the settings for 
Surcharges, Sort sequence and Time data once for each list. You can select material groups for 
some list types and enter comments. You can save all settings and use them for additional print 
jobs. 

1. Click on Print / Export in the toolbar.
 The Print / Export window appears.

2. Click on Lists.

Note

Graphics can be exported as figure or CAD files. To do so, select CAD file or Image file in 
the Output area.

Info

Additional information is available under Help under Print and export >Export graphic.

Tip

You can specify the Hourly rate and Value Added Tax for the total project in the Project 
window using the Change project data link.
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3. Select Current installation unit in the Source data area.

4. Click on Settings for all lists in the Lists area.

5. Enter settings for Surcharges, Display and General and confirm with OK.

6. Open the range of list types for Detailed Planning 3D in the Lists area and check the 
required lists.

7. Click on Settings for this list, to select Material groups and specify list type-specific data.
8. Confirm the settings with OK.

9. Select a printer in the Output area.
10. Select which pages you wish to print.

11. Click on Printer settings to enter additional settings for the printer.
12. Select the number of Copies in the Print area.
13. Click on Print to start the print process.

Note

If you wish to use settings for the list and list types for additional print orders, save the 
settings under a list name. To do so, click beside the list selection on .

Info

Additional information is available under Help under Print and export > Print lists.
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4.2 Planning a Complex Room

This chapter covers the following topics:

• Adapting module settings
• Drawing rooms
• Inserting doors and windows
• Free-drawing a partition wall
• Part-height, room-height prewalls
• Inserting duct inserts
• Placing objects
• Adapting object properties
• Inserting a recess

A graphic visualisation of the planning example can be found at the end of the training manual 
(see page 73).

4.2.1 Defining GIS Prefabrication

GIS installation walls can be prefabricated off site to save time and costs. The installation walls 
are divided into segments that do not exceed a certain size and take into account the structural 
conditions on site. 

You can define the corresponding settings in the Building and calculation settings window.

1. Click on the Building and calculation settings link in the Building window.
 The Building and calculation settings window appears.

2. Select the GIS tab.
3. Select the central installation unit Large bathroom.
4. Select Prefabricate in the GIS prefabrication area.

5. Click on Close to apply the settings.
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4.2.2 Adapting the Drawing Frame and Scale

The drawing frame and the scale for the subproject in the floor plan is adjusted for additional 
planning to ensure adequate space for the drawing.

1. Select the central installation unit, the Large bathroom, in the Building window. 

 The installation unit selected appears in the Design area window.

2. Double-click on the title block in the floor plan.
 The Paper format window appears.

3. Uncheck Apply the default settings.
4. Select the Paper format A3.
5. Select Landscape in the Orientation field.
6. Define the value 1:25 as the Scale.

7. Confirm the settings with OK.
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4.2.3 Drawing Rooms, Doors and Windows

Use the Masonry walls and installation walls window to plan rooms, doors and windows. 

4.2.3.1 Drawing a Room

You can draw rectangular rooms by entering the dimensions or draw rooms with single solid walls 
and lightweight walls. Opt for one version depending on your particular case. We will now show 
you how to draw a room by setting single solid walls.

Use the cursor entry to define the dimensions of the wall when drawing single walls:

As soon as you draw a wall, you can directly define the following dimensions with your cursor:

• Wall depth
• x and y coordinates with reference to the reference point
• Length

You can determine the wall length using the Length or the x and y coordinates.

Use the Tab key to jump between the single input fields. 

1. Make sure that the Masonry walls and installation walls window is open.

2. Select Solid wall in the Walls area.

3. Move the cursor into the drawing area.
 The cursor entry appears at the cursor.

4. Enter the value 15 in the Wall depth field.

Info

Additional information on walls can be found under Help at Detailed Planning 3D > Placing 
and adapting walls > Drawing rooms and walls.
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5. Click in the drawing area to set the starting point of the first wall.
6. Enter the value 550 in the Length (L) field and confirm with Enter.
 A 550 cm long wall is drawn.

7. Move your cursor downwards to indicate the direction of the next wall segment.
8. Enter the value 360 in the Length (L) field and confirm with Enter.
 A 360 cm long wall is drawn.

9. Move your cursor to the left to indicate the direction of the next wall segment.
10. Enter the value 550 in the Length (L) field and confirm with Enter.
 A 550 cm long wall is drawn.
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11. Press Esc to exit the drawing function.
 The Room completion window appears.

12. Select Close at point of intersection to complete the room.
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4.2.3.2 Reference Point

Geberit ProPlanner works with a reference point to which the walls and other objects are 
relatively aligned. The reference point is highlighted by a red point and two axes.

Fig. 4-1 Reference point with axes

The reference point is automatically assigned by default and is reset according to the highlighted 
object.

Automatically assigning reference points

The reference point is automatically assigned to install the windows and doors.

 Ensure that Assign reference point automatically is enabled.

Note

You can alternatively use the Room (solid wall) function to create a simple rectangular room.

To do so, enter the dimensions of the room in the Room (solid wall) window.

Note

• When placing an object, the position of the cursor (for example on the inner or outer edge 
of a wall) affects where the reference point is placed

• In some cases it may be advantageous if the reference point is assigned manually for the 
planning of distances (see page 41)

Info

Additional information can be found under Help at Detailed Planning 3D  > Reference 
point
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4.2.3.3 Inserting Windows

You can insert windows as required in the masonry and then adapt all dimensions, e. g. the width 
or parapet height.

1. Select the Window in the Doors and windows area.

2. Position the cursor on the inside edge of the left wall. Consider when doing so the position of 
the reference point.

3. Use the cursor to enter the following values:
• X-coordinate (x): 105
• Width (W): 160
• Height (H): 80
• Parapet height (PH): 90

4. Press Enter to set the window.
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4.2.3.4 Inserting Doors

You can insert doors as required and then adapt the properties, e.g. the hinge side and the 
opening direction.

Inserting the first door

1. Select the Door (76x200.5) in the Doors and windows area.

2. Position the cursor on the upper wall of the room and specify that the door opens inwards. 
Consider the position of the reference point.

3. Enter the value 201 in the cursor entry in the X-coordinate (x) field:

4. Press Enter to place the door.
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Inserting the second door

To place the second door, first manually set a reference point in the top right corner of the room. 
The hinge side of the door will be changed at the end.

1. Select Set reference point.
2. Move the cursor to the top right corner of the room. 

3. Click to place the reference point.
4. Move the mouse in a circular motion to position the x-axis along the long inside wall.

5. Click to place the reference point.
6. Highlight once again the Door (76x200.5) in the Windows and Doors area.

7. Position the cursor on the upper wall of the room and specify that the door opens inwards.
8. Enter the value 136 in the cursor entry in the X-coordinate (x) field:

 

Note

Note that the value that you enter in the cursor entry is measured in the direction of the x-
axis. Ensure also that the x-axis of the system axis is pointing in the right direction.

Note

The value for the x-coordinate represents the distance of the door from the right wall side and 
is made up of the distance of the right door edge to the wall and the door width.
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9. Press Enter to set the door.

10. Highlight the door.
11. Right-click on the door and select Change hinge side in the pop-up menu.

12. Select Assign reference point automatically.

4.2.4 Drawing Prewalls and Partitions

Use the Masonry walls and installation walls window to plan Geberit Duofix and Geberit GIS 
installation walls.

Geberit GIS installation walls are planned in the example. Plan Geberit Duofix installation walls in 
the same way. You can plan installation walls in 2 different drawing modes:

Drawing mode Description

Free
For manual drawing (draft of traverse) along a solid construction or 
lightweight wall or as a free wall in the drawing area.
The depth of the installation wall is defined by using the cursor entry
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4.2.4.1 Inserting Partitions and Room Separators

Once you have drawn your room with doors and windows, it is now time to insert the installation 
walls. First draw the room-height partition wall and the room separator from the planning 
example. The partition wall divides the entire width of the room to create two separate rooms. 
The room separator divides only one area of the installation.

Inserting partition walls

1. In the Installation walls area, select the GIS installation system.

2. Highlight the room-height room separator.

3. Select Auto drawing mode.

4. Move the mouse along the upper inner side of the room to the approximate position of the 
partition to be inserted.
 A preview of the wall is displayed.

The reference point lies on the left side and the wall depth is added on the right.

Auto
Adapts the installation wall to a solid or lightweight wall.
The depth of the installation wall is defined by using the cursor entry

Drawing mode Description
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5. Press the Z key.
 The wall depth is now added to the left of the reference point.

6. Enter the value 24 in the Wall depth field and the value 149 in the X-coordinate (x) field.

7. Confirm with Enter to place the wall.

 

Inserting free-standing GIS walls

To insert a free-standing GIS wall as a room separator, first manually set the reference point in the 
upper left corner of the room with the x-axis pointing downwards.

1. Click on Set reference point in the toolbar and set the reference point in the upper left corner 
of the room so that the x-axis is pointing downwards.
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2. Highlight the free-standing, room-height wall in the Installation walls area.

3. Select the Free drawing mode.

4. Move the cursor into the drawing area.
 The cursor entry appears at the cursor.

5. Enter the value 24 in the Wall depth field, the x-value 88 for the horizontal and the y-value 
120 for the vertical.

6. Confirm with Enter.
 The cursor is placed with the coordinates entered and the starting point of the partition is 

set.

7. Move the mouse so that the partition wall points downwards.

8. Enter the value 175 in the Length (L) field and confirm with Enter.
 The wall is drawn with the length entered.

9. Press Esc to exit the function.
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4.2.4.2 Inserting Prewalls

Your planning continues with 3 prewalls once you have inserted the partition wall and room 
separator. First insert 2 room-height prewalls and then draw a part-height prewall on the right 
side wall.

Inserting the first room-height prewall

1. Select Assign reference point automatically.
2. Select the room-height prewall in the Installation walls area.

3. Select the Free drawing mode. 

4. Enter the value 19 in the Wall depth field.

5. Click in the top right corner of the room to set the starting point of the room-height prewall.
6. Move your cursor upwards to indicate the direction of the next wall segment.
7. Enter the value 105 in the Length (L) field.

8. Press Enter to set the room-height prewall.
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Inserting a part-height prewall

1. In the Installation walls area, highlight the part-height prewall.

2. Select Auto drawing mode.

3. Position the cursor at the planned position.
4. Enter the value 120 in the Height (H) field.

5. Press Enter to set the part-height prewall.

Inserting the second room-height prewall

1. In the Installation walls area, highlight the room-height prewall.

2. Select Auto drawing mode.

3. Enter the value 15 in the Wall depth field.
4. Position the cursor at the planned position and click.
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Inserting duct inserts

You need ducts to be able to plan pipes for water supply connections, heating, ventilation and 
the electrical installation. First insert a duct insert so that you can place a duct on the part-height 
GIS prewall.

1. In the Installation walls area, highlight the Duct insert.

2. Select the Free drawing mode.

3. Click in the top right corner of the room to set the starting point for the duct insert.
4. Enter the value 25 in the Length (L) field.

5. Press Enter to set the duct insert.

Inserting a corner wall

Place the corner wall once you have inserted the prewalls. 

1. In the Installation walls area, highlight the room-height corner solution.

2. Select the Free drawing mode.

3. Move the cursor into the lower right corner of the large room so that a cross-hair with a yellow 
circle become visible.

Info

For additional information about duct planning, refer to the Help at Detailed Planning 3D > 
Placing and adapting installation walls > Duct plan.

Note

You will recognise the different profile constructions of the room-height prewall and the duct 
insert as soon as you see the installation wall in the front view.
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4. Enter the value 80 in the Length (L) field.

5. Press Enter to set the corner wall.

6. Press Esc to exit the function.

4.2.5 Placing Objects

You can select the objects for your installation in the Objects window. Default objects in the small 
room on your plan are set first and the shower is adjusted to the specifications of the planning 
example. The large room is planned with an example showing how you can set a specific object 
instead of a default object. Finally set the recess in the shower.

Info

Additional information can be found under Help at Detailed Planning 3D > Placing and 
adapting objects.



50

Detailed Planning 3D Planning Examples

Planning a Complex Room

Detailed Planning 3D Training Manual
Geberit ProPlanner 2016

4.2.5.1 Adapting the View

 Click on Window in the View menu and select Objects.
 The Objects window appears.

In the Objects window you can select between the Large symbols and Tree views.

The standard view with large symbols is used for this section in the training manual. You can 
change to the Tree view using the right mouse key pop-up menu.

Expand the tree structure using the triangle in front of the entry and select a specific object. 
Otherwise the default object will be used.

Note

The default object is market-dependent. The figures shown here can therefore differ from 
your view in Geberit ProPlanner.
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4.2.5.2 Inserting Objects into the Small Room

Inserting the washbasin

1. Ensure that Assign reference point automatically is enabled.

2. Select Washbasin in the Objects window.

3. Position the cursor at the top end of the part-height prewall.
 A preview of the object as well as the cursor entry appear.

The reference point is at the top end of the part-height prewall.

4. Make sure that the reference point is at the top and enter the value 100 in the X-coordinate 
(x) field.

5. Confirm with Enter to set the washbasin.

Tip

Start with the left object if several objects are placed on the same wall. You can place the 
additional objects by specifying the distances from the middle of the respective object. Note 
that the distance in the cursor entry always relates to the reference point.
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Inserting a WC

1. Select the WC in the Objects window.

2. Position the cursor on the part-height prewall so that the reference point is at the lower end 
of the part-height prewall.

3. Enter the value 60 in the X-coordinate (x) field.
4. Confirm with Enter to set the WC.

Inserting a shower

When entering objects, Geberit ProPlanner checks the respective installation situation. Faulty 
installation situations are listed in the Message list. In many cases, Geberit ProPlanner offers 
automatic correction of the error.

To meet this function, the shower is intentionally set incorrectly in the following step.

1. Select Shower in the Objects window.
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2. Use your mouse to place the shower so that the shower projects behind the wall.

3. Click in the drawing area to set the shower.
 The shower is set "behind the wall" and appears red in the Design area window.

Adapting ceramic sanitary appliances

The default shower object does not conform to the specification of the planning example. In this 
step you will now adapt the size of the shower in line with the specification. You will then move the 
shower tap.

1. Highlight the shower.
2. Right-click on the shower and select Properties in the pop-up menu.
 The Shower properties window appears.

3. Select the Ceramic appliance tab.

4. Click on Add new ceramic appliance.
 A new line appears in the table.
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5. Enter the following data. Press Tab key to jump from entry to entry.
• Model: 90x130
• Manufacturer: Neutral
• L [cm]: 90.0
• W [cm]: 130.0
• H [cm]: 8.0
• Z1 [cm]: 5.0

6. Make sure that the line just created is highlighted.
7. Confirm with OK.
 The size of the shower has been adjusted.

Correcting placement of the shower

1. Hover with your cursor above the red highlighted shower.
 An error message appears.

2. Click in the error message on the Correct link to automatically rectify the error.
 The shower was set at the correct distance to the wall.
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Moving the shower tap

1. Highlight the shower.
2. Right click on the shower and select Positioning of tap in the pop-up menu.
 The Positioning of tap window appears.

3. Enter the following values to move the shower tap 10 cm to the left and to a height of 120 cm.

4. Confirm with OK.
 The shower tap has been moved.

4.2.5.3 Inserting Objects into the Large Room

Inserting a WC into the corner

1. Highlight a Geberit AquaClean Mera series WC with GIS mounting element, 112 cm or 114 
cm, in the Objects window.

Note

Negative values move an object to the left and/or downwards, while positive values move an 
object to the right and/or upwards respectively.
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2. Position the cursor on the corner wall of the large room.
3. Enter the value 40 in the X-coordinate (x) field.

4. Confirm with Enter to set the WC.

Inserting a bidet and urinal

 Set the bidet and the urinal as per the planning specification (see page 73). In each case, 
select the default object in the first layer.
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Inserting washbasins

1. Click on Show front view arrows in the toolbar to hide the front view arrow.
2. Set the two washbasins as per the planning specification as well (see page 73). In each case, 

select the default object in the first layer.

Inserting mounting plates

Mounting plates can be adjusted precisely to fit in the gaps between GIS profiles to fasten towel 
rails, soap dispensers etc.

The mounting plates are shown in the front view.

1. Click on Add front view in the toolbar.
2. Position the cursor on the free-standing installation wall between the washbasins.

 
3. Click in the drawing area to set the front view.
 The front view appears in the Front view window.

4. In the Masonry walls and installation walls window, select Mounting plate.



58

Detailed Planning 3D Planning Examples

Planning a Complex Room

Detailed Planning 3D Training Manual
Geberit ProPlanner 2016

5. Position the cursor to the left between the left washbasin at the point at which the mounting 
plate is to be inserted.

6. Click on the drawing area.
 The mounting plate is adjusted.

7. In the Masonry walls and installation walls window, select Mounting plate.
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8. Use your mouse to draw open an area to the right close to the right washbasin, which is to be 
filled with a mounting plate.

 A mounting plate is inserted which fills the entire highlighted area.

The profile in the middle of the mounting plate drawn belongs to the rear of the installation 
wall.

o

Inserting the bathtub

1. Switch back to the floor plan.
2. Highlight the bathtub in the Objects window.

3. Position the cursor approximately in the middle of the free-standing GIS wall.
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4. Click in the drawing area to set the bathtub.
 As there is insufficient space for the bathtub, the bathtub appears red in the Design area 

window and the Message list also shows a corresponding error message.

5. Highlight the bathtub.
6. Right-click on the bathtub and select Turn and then Turn counter-clockwise.
 The bathtub is turned 90° counter-clockwise and placed on the free-standing GIS wall.

7. Adjust the ceramic size of the bathtub to 175x75 cm (see page 20).
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8. To align the bathtub centrally on the free-standing GIS wall, right-click once again on the 
bathtub and select Positioning and then Centred in the pop-up menu.
 The bathtub is aligned centrally on the free-standing GIS wall.

Inserting a recess

To complete the planning example, insert the recess in the shower.

1. Highlight the Recess in the Installation walls area in the Masonry walls and installation 
walls window.

2. Position the cursor on the wall in the shower.
3. Use the cursor to enter the following values:

• X-coordinate (x): 45
• Width (W): 20
• Height (H): 40
• Parapet height (PH): 100

4. Confirm with Enter to set the recess. 
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4.3 Reproducing an Installation Wall on an Imported Plan

In the Detailed Planning 3D module, you can import different image files (e. g. AutoCAD DXF/
DWG, SVG, JPEG) and draw plans based on the imported graphics and images. This will now be 
explained in this section.

Selecting an installation unit

 Select the upper installation unit Guest WC in the Building window.

4.3.1 Importing a CAD Plan

Reading a CAD plan

1. Click on Import figure or CAD plan in the toolbar.
2. Select the training file in the Import figure or CAD plan window.
3. Click on Open.
 The CAD file is read and is suspended from the cursor.

4. Click in the drawing area to place the CAD plan.

Note

Download the training file from the following address if you do not have it: http://gpp-
update.geberit.com/Download/E-Learning/english/Training Manuals/.
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Specifying the scale

You need to specify the scale before being able to work with the scaled CAD plan. To do this , as 
long a section as possible is measured, the length of which is known.

1. Highlight the CAD plan.
2. Right-click on the CAD plan and select Obtain distance in the pop-up menu.
3. Click in the CAD plan on the upper left inner corner of the room to set the starting point of the 

section.

4. Click in the CAD plan on the upper right inner corner of the room to set the end point of the 
section.

The Image/CAD plan properties window appears.
5. Enter the value 255 in the New distance field.

6. Confirm with OK.

Tip

• The current section length is shown while the distance is measured
• You can zoom with the mouse wheel to get a better detailed view
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Colouring the CAD plan

You can colour the CAD plan to be able to identify the CAD plan and ensure that it differs more 
from the later drawing.

1. Highlight the CAD plan.
2. Right-click on the CAD plan and select Properties in the pop-up menu. 
 The Image/CAD plan properties window appears.

3. Select Colour CAD plan in the Visualisation area.
4. Click on Colour and select a colour.
5. Deselect Hide hatching and filling.

6. Confirm with OK.
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Fixing the CAD plan

We recommend fixing the CAD plan if a plan is to be drawn up based on the imported data. You 
can draw objects in the Design area window without the CAD plan being moved.

1. Click in the toolbar on Layer.
 The Layer window appears.

2. Activate the checkbox in the Locked column for the Background.

3. Confirm with OK.
 The CAD plan can no longer be selected and thus cannot be inadvertently moved or 

changed when drawing.

Info

Additional information can be found under Help at Detailed Planning 3D > Images and 
CAD plans.
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4.3.2 Drawing a Room

Reproducing walls

You can reproduce the plan as soon as you have specified the scale and fixed the CAD plan.

1. Highlight the solid wall in the Walls area in the Masonry walls and installation walls 
window.

2. Click in the CAD plan in the lower inner corner near the door to set the starting point of the 
wall.

3. Go around the room to the upper left corner.
4.  Click on each corner to set the corner points.
5. If required, press Z to change the wall side when drawing.
6. Press ESC to quit drawing the wall and select the open room completion.

Inserting a part-height prewall

1. In the Masonry walls and objects window, select the part-height prewall.

2. Select Auto drawing mode.
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3. Insert the part-height prewall with a height of 120 cm.

4.3.3 Inserting Objects

1. Select Washbasin in the Objects window.

2. Move the mouse over the CAD plan.
 The cursor automatically clicks into place at capture points in the CAD plan.

3. Place the washbasin above the washbasin in the CAD plan and click in the drawing area.

4. Select the WC in the Objects window.

5. Set the WC in the same way above the WC in the CAD plan.
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4.3.4 Hiding Layers

1. Click in the toolbar on Layer.
2. Deselect the checkbox in the Visible column for the Background.

3. Confirm with OK.
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5 Keyboard Shortcuts

You can use keyboard shortcuts to work more quickly with Geberit ProPlanner. You can select 
from general keyboard shortcuts and combinations that apply to the specific module.

Country-specific keyboard shortcuts are not listed here and can be requested from the 
respective sales company's hotline.

The keyboard shortcut for the respective functions is additionally displayed in brackets in the 
menus and tool tips.

5.1 General

Keyboard shortcut Description

Ctrl + C Copy: Copy selected objects to clipboard

Ctrl + A Select all

Press and hold down Ctrl + LEFT MOUSE 
KEY

Highlight several objects

Ctrl + X Cut: Remove highlighted objects and copy to 
the clipboard

Ctrl + V Paste: Paste objects from the clipboard

Del Delete highlighted objects

Alt+Enter Open properties of highlighted objects

Esc Cancel/Exit

F5 Calculate

Ctrl + F5 Calculate all

F1 Call up the Help function

F2 Rename

Ctrl + O Open existing document

Ctrl + S Save

Ctrl + P Print

Ctrl + Z Undo
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5.2 Detailed Planning 3D

Ctrl + Y Redo

Right mouse key Open pop-up menu

Ctrl + right mouse key Open pop-up menu

+/- (on numerical keypad) Zoom +/-

POS1 Return screen to starting position

Pressed MOUSE WHEEL Move drawing area

Rotate MOUSE WHEEL Zoom-in, Zoom-out

Keyboard shortcut Description

Keyboard shortcut Requirement Description

Tab key Coordinates field is 
activated when drawing 
walls and placing objects

Space bar All objects located in the 
area underneath the 
cursor are shown in a 
selection menu and can 
be selected that way 
(Plan view and Front 
view)

 Z Object with several docking sides is 
highlighted

Object changes docking 
side

Arrow keys Object or wall is highlighted in the plan 
view or front view

Move highlighted object 
a centimetre at a time

Ctrl + arrow keys Object or wall is highlighted in the plan 
view or front view

Move highlighted object 
a millimetre at a time

M One object is highlighted You can move the object 
with your mouse
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3D view:

Keyboard shortcut Requirement Description

Drag while holding down right 
mouse key

Rotation in the room

W Slide drawing to the front

S Slide drawing to the rear

A Slide drawing to the left

D Slide drawing to the right
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6 Overview of Planning Examples

Fig. 6-1 Small bathroom planning example (all dimensions in cm)
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Fig. 6-2 Large bathroom planning example (all dimensions in cm)
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Fig. 6-3 Guest WC planning example (all dimensions in cm)
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